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Chapter 1. What’s new in DB2 Alphablox 8.4 and 8.4.1

IBM® DB2® Alphablox for Linux®, UNIX® and Windows® Version 8.4 and Version
8.4.1 provide new functionality and platform support for broader deployment of
your applications.

The new functionality in the two versions includes the support for multiple locales,
Microsoft® SQL Server 2005 Analysis Services, vertical clustering for WebSphere®
Application Server, a new FastForward template for relational data sources, and a
new portlet that you can use in your portal application without any modification.
This release also enhances several highly useful features that make DB2 Alphablox
an even more powerful front-end tool for your analytical applications. These
enhancements include better Excel and PDF export functionality and the creation
of traffic lighting effects in charts. This release also continues to enhance the
support for creating and managing relational cubes using the DB2 Alphablox Cube
Server, with support for persisted calculated members, partial metadata caching,
metadata enhancements, and more MDX functions for filtering and statistics.

V8.4 or V8.4.1?

The two versions support the same features and functionality. The key difference
lies in the version of Apache Tomcat each supports and the security model and
version of servlet specifications supported by the specific version of Tomcat.

V8.4 supports Apache Tomcat 3.2.4, and V8.4.1 supports Apache Tomcat 5.5.17.
V8.4.1 is not a fix pack for V8.4. For details on the differences between these two
versions, see [“Differences between V8.4 and V8.4.1.”| See the topic on
[for upgrading to V8.4 or V8.4.1” on page 9[to help you decide which version is
right for you.

Differences between V8.4 and V8.4.1

Because V8.4 and V8.4.1 support different versions of Apache Tomcat, the two
differ in their security and personalization model, in their support for external Web
servers, and in how the DB2 Alphablox Tag Libraries descriptor files are referenced
by applications.

Supported servlet and JSP specifications

The following table shows the differences in the versions of servlet and JSP
specifications supported by the two Tomcat versions:

DB2 Alphablox

Supported version of

Minimum version of
servlet specifications

Minimum version of
JSP specifications

version Apache Tomcat supported supported
V8.4 Tomcat 3.2.4 Servlet 2.2 JSP 1.1
V8.4.1 Tomcat 5.5.17 Servlet 2.3 JSP 1.2

For information about the differences betwee
ttp:/ /tomcat.apache.org/whichversion.htm
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Security and personalization

Security and personalization are two closely related but different concepts. Security
involves user authentication and authorization. User authentication and
authorization is handled by the application server. DB2 Alphablox needs to obtain
that information from the application server and store the user properties in the
DB2 Alphablox Repository. This information allows application developers to
create personalized data views or user experience in an application.

Because Tomcat 3.2 and Tomcat 5.5 support different versions of servlet
specifications, setting up security based on Java Naming and Directory Interface
(JNDI), Java Authentication and Authorization Service (JAAS), or Microsoft IIS NT
LAN Manager is different in the two versions. With the support for JAAS and
JNDI in Tomcat 5.5, DB2 Alphablox is able to clearly separate the security model

and the personalization model.

security model based on the
standard servlet security APL
Security information is
configured directly in Tomcat’s
server.xml file.

The Authorized Client List
field in the DB2 Alphablox
home page (under the
Administration tab > General
page > System link) is
removed. Use the security
feature in Tomcat 5.5 instead.

For more information about the

security model, see Eecuritﬂ
[Model in Alphablox 8.4.1

DB2

Alphablox

version Security Personalization

V8.4 The DB2 Alphablox User Manager manages user authentication and

(Tomcat authorization as well as provides personalization capabilities.

32.4)  Use the ExtUserManager console command to specify the LDAP repository
and to automatically read user properties from the LDAP repository and
add them to the DB2 Alphablox Repository.

* Use the External User Manager API for custom security and
personalization implementation.

V8.4.1 With the support for JAAS and | The External User Manager is deprecated,

(Tomcat JNDI in Tomcat 5.5, DB2 replaced by the new Personalization

5.5.17) Alphablox now provides a Manager.

The new Personalization Manager provides
methods that notify DB2 Alphablox when a
user or a group is created, loaded, or
deleted. You can use Personalization
Manager API to specify and modify
properties on a user or group, or to modify
users and groups contained in a group. The
API also allows you to create your own user
or group and add it to the Alphablox
Repository.

External repository (LDAP or JNDI) to read
from is specified in the alphablox_dir/
repository /server/instance/config.xml file in
the DB2 Alphablox Repository.

For more information about the

Personalization Manager, see |Personalizatio

Supported external Web Servers

V8.4.1 no longer supports SunOne iPlanet 6.0 Web server, or Apache HTTP Server
V1.3. The following table shows the supported external Web servers for Apache

Tomcat.
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DB2 Alphablox
version

V8.4 (Tomcat 3.2.4)

Supported external Web servers

Microsoft IIS 5.0.1, 6.0 on Windows; Apache HTTP Server 1.3;
SunOne iPlanet 6.0

V8.4.1 (Tomcat 5.5.17) | Microsoft IIS 5.0.1, 6.0 on Windows; Apache HTTP Server 2.0

Locations of DB2 Alphablox tag library descriptor (TLD) files

The locations of where the TLD files are stored in DB2 Alphablox and in your
applications are different in the two versions. This difference does not impact how
you reference the tag libraries in your JSP. In both versions, you use the same JSP
taglib directives to reference the DB2 Alphablox Tag Libraries descriptor files. The
only difference is in how you set up your development environment to reference
the DB2 Alphablox Tag Libraries descriptor files.

The following table shows the location where the TLD files are stored:

DB2
Alphablox
version

Location of TLD files on the
installed Alphablox instance

Location of the TLD files in your
application

V8.4
(Tomcat
3.24)

Separate TLD files stored in the
alphablox_dir /bin directory.

Separate TLD files are copied into
your application’s WEB-INF/tlds
directory when you define a new
application through the DB2
Alphablox Admin Pages.

V8.4l
(Tomcat
5.5.17)

An aastaglibs.jar file stored in the
alphablox_dir/lib directory.

The aastaglibs.jar file is copied into
your application’s WEB-INF/lib
directory when you define a new
application through the DB2
Alphablox Admin Pages.

Newly supported platforms

Newly supported platforms in this release include:

* Hyperion Essbase 7.1.5 and Hyperion System 9

* Microsoft SQL Server 2005 Analysis Services

* Microsoft SQL Server 2005
* Vertical clustering for WebSphere Application Server
* Tomcat 5.5 (DB2 Alphablox V8.4.1 only)
* Apache HTTP Server V2.0 for Tomcat 5.5 (DB2 Alphablox V8.4.1 only)

See the [system requirements| topic in the Installation Guide.

Restriction: Microsoft SQL Server 2005 Analysis Services has a new feature that
allows administrators to specify perspectives, which are viewable
subsets of the hierarchies in a cube to simplify the view for end users.
DB2 Alphablox does not completely support this new feature. DB2
Alphablox metadata APIs will support perspectives, but result set
APIs do not. The difference can be observed in the discrepancies
between the Member Filter and the Data Layout panel. Member Filter
is built by making metadata API calls, so it will display only the
hierarchies contained in the specified perspective. The hierarchies
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displayed in the Data Layout panel and the results of the
DataBlox.getQuery() method are built from result set API calls.
Therefore, they ignore the perspective specified in the query and
return all hierarchies defined for the underlying cube.

Support for multiple locales

This release adds the support for multiple client locales. Regardless of the server’s
locale, the Blox user interface, the FastForward application framework, and the
Query Builder tool are now displayed based on the browser’s language setting. For
languages that display from right to left, the Blox user interface will automatically
display correctly and there is no longer the need to programmatically set the
direction.

For applications with modified or custom Blox UI components, a set of custom JSP
tags are available for you to import your resource bundles. This functionality
allows you to internationalize your application to support multiple client locales.
For details on designing applications to support multiple locales, see the topic on
[Designing for multiple locales}

Note:
* ReportBlox user interface does not support multiple locales.

* Query Builder and the FastForward do not support bi-directional
languages.

DB2 Alphablox Cube Server enhancements

4

The DB2 Alphablox Cube Server enables multidimensional analysis on top of
relational data stored as a star schema or snowflake schema. You can create a
multidimensional representation of your relational data or use the metadata from
an existing cube definition in DB2 Cube Views " through the DB2 Alphablox Cube
Server administration page.

This release adds the following support and enhancements:
* Support for calculated member definitions in cube definitions
* Support for parent-child recursive hierarchies

* Support for level key. Level key expressions allow member uniqueness to be
better enforced.

* All level and all member support. Dimensions are extended to specify if a
dimension has an "All"” level or not, and to optionally specify the all member
name.

* Support for dimension type. Dimensions can now be marked as Regular or
Time. This enhancement makes it possible to eliminate the previous limitations
on the support for time series-related MDX functions.

* Support for level types. This release extends the levels in a cube definition to
have one of the following types:

- REGULAR

- TIME

- TIME_YEARS

- TIME_HALF_YEARS
— TIME_QUARTERS
- TIME_MONTHS
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— TIME_WEEKS

— TIME_DAYS

— TIME_HOURS

— TIME_MINUTES

- TIME_SECONDS

— TIME_UNDEFINED
- UNKNOWN

* Scalability enhancements. There is now a tuning parameter setting for member
caching. You can use the member cache to reduce the memory requirements for
cubes with large numbers of members.

* Additional MDX functions and operators:

Category Functions or Operators

Filtering functions Filter, IIF, IsEmpty
Time series functions YTD, QTD, MTD, WTD

Full support to existing functions: OpeningPeriod, ClosingPeriod,
ParallelPeriod, LastPeriods, PeriodsToDate

Statistical functions Variance:
e Variance: Var, Variance, VarP, VarianceP
* Standard deviation: Stdev, Stddev, Stdevp, Stddevp

Item operators and Aggregate, CoalesceEmpty, NonEmptyCrossjoin, Ordinal,
functions NameToSet, Rank, DataMember, A11Members
Operators Is, And, Or, Not, XOR, >, >=, <, <=, =, <>

For more information, see [Supported MDX syntax|in the DB2 Alphablox Cube Server
Administrator’s Guide.

Export to Excel enhancements

DB2 Alphablox now exports data to native Excel format through Excel templates
and macros. When users click the Export to Excel button in the user interface, they
can choose from the two provided templates, or they can choose not to use any
template.

* The Default template exports data in the grid to Excel and then generates the
chart based on the grid data. Because the chart is generated from the grid data:
— Changes to the exported grid data will automatically update the chart.

— The chart generated in Excel might not look the same as the one in DB2
Alphablox.

e The Use Chart Data template exports the chart’s data onto a separate worksheet
from the grid and then generates the chart. Because the chart is generated using
the chart’s data from DB2 Alphablox:

— The chart is more similar to the one in DB2 Alphablox.

— The grid data and the chart data are not linked. Changes to the exported grid
data will not update the chart.

* The No template option simply sets the MIME type of the output to
application/vnd.ms-excel. This MIME type triggers the browser to launch the
Excel application to display the HTML page. This option does not involve the
use of any Excel template or macros.
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Application developers can create custom templates based on the properties DB2
Alphablox exports to the Excel worksheet. See the topic on [Exporting data to Excell
for more information.

Export to PDF enhancements

This release provides users with more control over the layout of the generated PDF
report. Application developers now also have the ability to create PDF reports
without a browser session.

More user control over layout

When users click the Export to PDF button in the Blox user interface, a Create
PDF Report dialog opens, allowing the users to specify the report layout. In
addition to the general settings on page orientation, page size, header text, and
footer text, this release gives users the ability to:

* Fit data columns in a grid onto multiple pages

* Specify the height and the width for charts

For more information, see '[Default user interface options for PDF reports]'.

Saving a PDF report without a browser session

Previously you could not save a PDF report unless the JSP page is loaded into a
browser. With the new writePDFToFile() method, you can now call the JSP page
in your Java code to save a PDF report directly into a specified file name and
location. See "[Specifying PDF storage locations and file names|' for more
information.

Charting APl enhancements
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You can now create traffic lighting effects in charts by setting data series colors
based on their values through the API. Several new objects and APIs are provided
for controlling the chart’s legend, identifying the data point in the chart that the
user interacts with, and creating custom trendline algorithms. There is also a new
chart type called the contribution chart.

Setting colors to data series

You can now create traffic lighting effects in charts, calling users” attention to the
data by setting specific colors for data series based on the data values. Similar to
the cell alert feature in GridBlox, you can specify several threshold values and
apply different colors to the data series based on the threshold values. See [Using]
[chart series colors to highlight datal for more information.

More programmatic control over the legend

A new Legendltem class is added to the
com.alphablox.blox.uimodel.core.chart.common package to give you programmatic
control over the legend items in a chart, such as specification of which legend
items to show, the order they should be in, their colors, and their display text. See
the "Setting colors and display labels for legend items” section in the topic on
1Using chart series colors to highlight data|' for more information.
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New APIs for identifying the data point associated with user
interactions

You can now find out more information on the data point the user acts on in the
chart. For example, you can write your own controller for DoubleClickEvent to
find out exactly which data point in the result set the event applies to. New
methods are added to ChartBrixModel to allow you to get the unique group
members, series members, and filter members for the data point.

Custom trendline algorithms

You can now implement your own trendline algorithm. DB2 Alphablox offers six
types of trendlines— linear, logarithmic, polynomial, power, exponential, and
moving averages. You can create your own algorithm by extending the
AbstractTrendingAlgorithm class. This is an API-only enhancement; custom
algorithms do not show up in the trendline selection dialog. See the ”
ChartBlox tag attribute for more information.

Contribution charts

Contribution charts are similar to "stacked waterfall” charts. They provide a
visualization of two related variable series. For example, if a product is on sale,
using the contribution chart, you can examine whether this special sale has any

I

"pull effect” on the sales of an adjacent product on the same shelf. See the
"lcontribution!’ ChartBlox tag attribute for more information.

New FastForward template for relational reporting

DB2 Alphablox FastForward is a sample application framework for quickly
developing, deploying, and sharing custom analytic views. Application
administrators can quickly create and publish reports by selecting report templates
and configuring report parameters, and then deploy the new application.

This release adds a new FastForward template for relational data using ReportBlox.
You can now easily create a relational reporting application using this sample
template with all its built-in features, including easy saving and sharing of
personal views of data and easy navigation. This template shows up in the
template drop-down list on the FastForward administration page as Sample
Report Blox.

New Alphablox portlet with bookmark persistency

This release provides a new portlet that you can use without any modification.
This portlet offers options for users to:

* Dynamically switch data sources

e Turn on and off the menu bar and toolbar

Users can interact with the data using the Blox user interface and create
bookmarks for different data views. Public bookmarks created within one portlet

are available to other instances of the same portlet on the portal page. This feature
allows portal users to compare different data views without having to leave the

page.

This AlphabloxPortlets.war file is available in the <alphablox_dir>/installableApps
directory. System administrators can install it using WebSphere Portal’s
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administrative user interface, create public bookmarks from various data views,
and specify the bookmark for the default data view when the portlet is loaded by
portal users.

Printer rendering format based on the Blox Ul model

The Printer rendering format (render=printer) generates a view of a Blox’s data
that is optimized for printing purposes using the browser’s built-in printing
functionality. In this release, the Printer rendering format has been modified to
generate the views based on the same Blox Ul model that the DHTML client is
built on. This means the data views in the DHTML client will be preserved,
including any custom layout such as the butterfly layout or grid spacers.

In the Printer rendering format, the selected page filters are converted to a list that
includes the dimension names and their selected members. The menu bar and the
toolbar, however, are not included in the generated views.

Additional language support
DB2 Alphablox V8.4 and V8.4.1 add the support for Turkish.

Below is a list of all languages supported:
* Arabic

* Chinese - Simplified
* Chinese - Traditional
* Czech

e English

* French

* German

* Greek

* Hebrew

* Hungarian

* Japanese

* Korean

e Italian

e Polish

* Portuguese - Brazilian
* Russian

* Spanish

* Turkish
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Chapter 2. Upgrading and migrating to V8.4 and V8.4.1

An upgrade installs DB2 Alphablox on the physical system that contains a
previous version of DB2 Alphablox instance.

Important:

* Before you upgrade or migrate your a
V8.4 or V8.4.1, you should review the

plications to DB2 Alphablox

“Scenarios for upgrading to|

8.4 or V8.4.1"| to decide whether V8.4 or V8.4.1 is the right version
for you.

* If you are currently using Tomcat with DB2 Alphablox and choose to
upgrade to V8.4.1 for Tomcat 5.5, follow the [“V8.4.1-specific upgrade|

fand migration tasks” on page 10

¢ For both V8.4 and V8.4.1 upgrade:

Perform the |general migration tasks described in this section|

Review the readme file on the DB2 Alphablox CD for any
additional migration or development tips and issues.

If you are migrating from a version older than V8.2.1, you must

review [additional upgrade and migration information|

Scenarios for upgrading to V8.4 or V8.4.1

DB2 Alphablox V8.4.1 removes Tomcat 3.2.4 support and adds the support for
Tomcat 5.5. You need to determine if V8.4 or V8.4.1 is the right version for you.

The following table shows the different upgrade scenarios to help you determine if
you should upgrade and which version to choose.

Your current
application server

Purpose for
upgrades

Version of DB2
Alphablox to upgrade
to

Migration tasks

WebSphere
Application Server

and BEA WebLogic

Server

Upgrade to the latest
version of Alphablox
for new features.

V8.4

Follow the |Installatio;|
Igiuide| to install DB2
Alphablox. Provide the
directory where your
DB2 Alphablox instance
was installed when you
are prompted by the
installer.See I”_GQ%MII
migration tasks” onf

page 11|

Apache Tomcat
3.2.4

Upgrade to the latest
version of Alphablox
for new features, but
want to stay with
Tomcat 3.2.4

V8.4

Follow the |Installatio;|
Igiuide| to install DB2
Alphablox. Provide the
directory where your
DB2 Alphablox instance
was installed when you
are prompted by the
installer.

See [“General migration|
[tasks” on page 11

© Copyright IBM Corp. 1996, 2006
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Your current
application server

Purpose for
upgrades

Version of DB2
Alphablox to upgrade
to Migration tasks

Apache Tomcat

324

Upgrade to Tomcat |V8.4.1
5.5 to take advantage
the features of tasks.”|
Tomcat 5.5, such as
support for Servlet
2.4 and JSP 2.0 and
better security.

See |”V8.4.1—speciﬁc|

upgrade and migration|

V8.4.1-specific upgrade and migration tasks

This section lists the high-level tasks involved to upgrade to DB2 Alphablox V8.4.1
and to migrate your existing applications based on Tomcat 3.2.4 to Tomcat 5.5.

10

Task

Details

Install and configure
Apache Tomcat 5.5.

Before you install DB2 Alphablox 8.4.1, you must install
and configure Apache Tomcat 5.5.17 first. Tomcat 5 does not
support upgrading from the previous version of the server.
Follow the Tomcat documentation to configure your server.
Apache Tomcat is available from fhttp://tomcat.apache.org/|
download-55.cg;'l Documentation is available from

http:/ /tomcat.apache.org /tomcat-5.5-doc/index.html}

Important: If you are using Apache HTTP Server for your
Web server:

* Follow the Tomcat configuration documentation to ensure
that you have a host that is named after your machine
name rather than just the default Tocalhost. Without this
step, you can only access the server from the same
physical machine where Tomcat 5.5 is installed.

* DB2 Alphablox 8.4.1 no longer ships the Apache Web
Server Connector for Tomcat. You need to download the
mod_jk DLL file from the Apache web site.

For detailed information, see [pre-installation steps for using]
[the Apache HTTP Server 2.0 on Alphablox 8.4.1] Make sure
your Tomcat server can start up and shut down properly
before you proceed further.

Backup your
applications and
repository.

Keep a copy of your applications and related data.

Upgrade to DB2
Alphablox 8.4.1.

Follow the [[nstallation Guide|to install DB2 Alphablox.
Provide the directory where your DB2 Alphablox instance
was installed when you are prompted by the installer. See
|[Using Apache Tomcat 5.5 with Alphablox 8.4.1| for the
installation steps.

Start up DB2 Alphablox
and go to the DB2
Alphablox Admin
Pages.

—_

Start up DB2 Alphablox by starting up Apache Tomcat.

2. Go to the DB2 Alphablox Admin Pages and login as an
administrative user. The default user name is admin, and
the password is password unless you configured Tomcat
differently. The URL is http:/ /your_server:port/
AlphabloxAdmin/home.

The DB2 Alphablox Application Migration Utility
automatically pops up.

IBM DB2 Alphablox: Release Overview
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Task Details

5 Migrate your Alphablox | The DB2 Alphablox Application Migration Ultility is
applications. provided to help you update the Tag Library Descriptor
(TLD) files and the servlet specification version for your
applications. This utility automatically pops up the first
time you go to the DB2 Alphablox Admin Pages after the
upgrade. It is also available from the DB2 Alphablox Admin
Pages under the General link > Utilities section.

All migrated applications are automatically deployed to the
Tomcat 5.5 server.

6 Migrate your custom The External User Manager is deprecated in V8.4.1.

security and * If you currently use JNDI- or LDAP-based user
personalization. repository, follow the steps in|Accessing JNDI user and]
from an external user repository to

migrate your security and personalization information.

 If you currently use Microsoft Internet Information Server
NT LAN Manager (NTLM) for user authentication,
follow the steps in [Setting Microsoft Security Options for]

* If you have your own custom security model using the
Extensible User Manager APIs, you need to write a JAAS
login module. See [Security Model in Alphablox 8.4.1

7 If you are using DB2 Alphablox 8.4.1 no longer ships the ISAPI redirect DLL
Microsoft Internet file. You need to download the DLL file from
Information Server (IIS), ||http://tomcat.apache.org/download-connectors.cgil Follow
download the ISAPI the post-installation steps in [Using Microsoft IIS with DB2|
redirect DLL file. [Alphablox 8.4.1 on Apache Tomcat installations}

8 Perform other general See [“General migration tasks.”|

migration tasks.

General migration tasks

The following migration tasks apply to both V8.4 and V8.4.1 unless noted
otherwise.

Repository migration
Database-based repository

If you are using a database for your repository and want to support multiple client
locales when upgrading to V8.4 or V8.4.1, you should make sure that you use a
UTF-8 database. Using a non-UTF-8 database can cause problems with double-byte
characters when users create bookmarks.

Starting this release, Sybase as a database repository is no longer supported
(connection to Sybase for data analysis is still supported). You should use the
Repository Conversion Utility to convert to a different database or to a file system
for your repository BEFORE you upgrade to DB2 Alphablox V8.4 or V8.4.1. The
utility is located in the alphablox_dir/tools/convert/ directory in your existing DB2
Alphablox installation.
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File-based repository

If you are using a file-based repository and want to support multiple client locales
when upgrading to V8.4 or V8.4.1, you should run the NativeConverter.bat or
NativeConverter.sh utility in the alphablox_dir/bin directory after the upgrade. This
tool converts your repository from character-based encoding to UTF-8. See the
topic on 'Migrating a DB2 Alphablox Repository to support multiple locales]’ in the
Installation Guide.

Essbase runtime client libraries

Hyperion Essbase runtime client libraries are no longer included with DB2
Alphablox installation. You need to install the Essbase runtime client library first
and run the ChangeEssbase.bat or ChangeEssbase.sh script to have the
ARBORPATH point to your Essbase client library before DB2 Alphablox is started.
If you are upgrading, you can copy your previous client libraries under
<alphablox_dir>/bin/{nt, eds} to another location and then run the ChangeEssbase
utility.
1. Choose option 4 to configure DB2 Alphablox to use existing DB2 OLAP
Server or Hyperion Essbase client libraries.

2. Select the version of the client libraries to use.
3. Provide the fully qualified path to where the client libraries are stored.
4. Restart DB2 Alphablox for the changes to take effect.

Upgrading from a clustered environment

Always use the step-by-step installation option to upgrade to V8.4 and V8.4.1 if
your DB2 Alphablox operates in a clustered environment. This allows you to verify
the preservation of your existing clustering setup.

Upgrading from a non-English system

Always use the step-by-step installation option to upgrade to V8.4 and V8.4.1 if
your previous version is installed on a non-English system. This allows the
installer to gather the correct settings from your current environment.

Microsoft SQL Server 2005 Analysis Services

If you are upgrading to SQL Server 2005 Analysis Services, check the following list
for potential migration steps.

* You must install MSXML, version 6 and SQL Server 2005 Analysis Services 9.0
OLE DB Provider, obtainable from Microsoft.

* To connect to Analysis Services in both SQL Server 2000 and SQL Server 2005,
you need to install both PivotTable Services 8.0 and Analysis Services 9.0 OLE
DB Provider in a side-by-side configuration.

* In cases where you installed PivotTable Services 8.0 after installing Analysis
Services 9.0 OLE DB Provider, for the data sources using the OLE DB for OLAP
adapter, you must start the Provider string with MSOLAP.2 to connect to SQL
Server 2000 Analysis Services data sources or MSLOAP.3 to connect to SQL Server
2005 Analysis Services data sources.

* SQL Server 2005 Analysis Services was re-architected to allow dimensions to
truly support multiple hierarchies. Dimensions that contain more than one
hierarchy must have the property HierarchylUniqueNameStyle set to
IncludeDimensionName. This allows DB2 Alphablox to determine which
dimensions to merge to create a logical dimension, allowing the use of multiple
hierarchies.
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FastForward template-related changes

The FastForward application framework has been modified to support multiple
locales. You will need to perform the following migration steps for your existing
applications that were built on FastForward templates. The steps involve copying
the new FastForward Java classes, supporting JSP files, and Blox tag libraries into
your application.

After upgrading to DB2 Alphablox V8.4 or V8.4.1:

1.
2.

Back up your application.

Go to the system/ApplicationStudio/FastForward directory in your DB2
Alphablox installation.

Copy the files and folders under the FastForward directory, except WEB-INF,
into the directory where your application is located.

Go into the WEB-INF directory under system/ApplicationStudio/FastForward.

Copy the classes, src, ui, and tlds directories, into your application’s WEB-INF
directory.

Important: If your FastForward-based application has been significantly modified

General

and cannot have your custom JSP overridden, you should, at a
minimum, perform the following steps:

1. Back up your application.

2. Go to the system/ApplicationStudio/FastForward directory in your
DB2 Alphablox installation.

3. Copy apperror.jsp and error.jsp into your application directory.

4. Go into the WEB-INF directory under system/ApplicationStudio/
FastForward.

5. Copy the classes and src directories into your application’s
WEB-INF directory.

These steps will leave most of your application intact, but you might
need to perform additional steps depending on how your code is
customized. Check the [DB2 Alphablox support Web site| for related
technotes.

application development-related changes

Because the Blox user interface is displayed based on the client’s locale, if you
have custom code that sets the locale, it is no longer needed. The
setLocaleCode() method has been removed from this release, so make sure you
are no longer using this method or the TocaleCode tag attribute in your
application.

The Query Builder tool in the previous releases uses a method that has been
removed in this release. When you upgrade to V8.4 or V8.4.1, if you run into
errors loading the Query Builder tool, your application server is using the
previously compiled version. You will need to remove the temporary files for
Query Builder from the Application Server’s temporary work directory. This will
force the application server to recompile the JSP files for the new version of
Query Builder.

DHTML themes-related changes

The layout strings for the DHTML client theme have been deprecated, and are
no longer applied by default. If you want to continue to use them, you need to
explicitly apply it using the BloxModel.setApplyThemelLayout () method.
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* To support bi-directional languages, the default style definition for some of the
CSS theme classes have been modified. These changes should not affect your
applications. If you have customized the style sheet, you should test your
applications to find out how the changes affect you.

Theme classes

Style change

Component border — borders of individual
Blox and controls:.csCmpBrdr

The following cell margin setting is
removed:

cellmargin: 1lpx;

Interactive buttons:.csIBtnDprsd,
.csIBtnDprsdHghlght, .csIBtnHghlghtDprsd,
.t1BtnDprsd, .csIBtndrpDwnDprsd,
.csIBtndrpDwnDprsdHghlght

The following display setting is removed:

display: inline;

Horizontal separators:.hsprtr

The following margin, border, width, and
height settings have changed:

margin: 2px Opx 2px Opx;
text-indent: Opx;
font-size : Opx;

width: 100%;
border-bottom: Opx;
border-left: Opx;
border-right: Opx;
height: Opx;

Tree nodes and leaves:.csTrNdLbT,
.csTrLfLb1, .csTrNdLb1STctd,
.csTrLfLb1STctd, .csTrLfLbl

The SPAN element has been removed from
these classes.

Calendar component:.csCIndrBdy, .csDys,
.csWkdy, .csTdy, .csSmDte, .csStDte,

.csExprd

Text alignment has changed:

text-align: center;

after you migrate to V8.4:

DB2 Alphablox Cube Server-related changes

Below are some changes that take place when you open an existing cube definition

* Cube Server cube definitions are migrated from previous releases to V8.4 and

V8.4.1. The migration is necessary due to the new cube definition metadata
features. The migration occurs automatically each time the cube definition is
read by DB2 Alphablox. If you open a cube definition to edit and then save it,
the migrated cube is saved and no longer needs to be migrated. After migration,
the version number in the cube definition is 3.0.

 After migration, each level will have one or more level key expressions. There

will be one level key expression that is the same as the level expression. There
will also be one level key expression for each ancestor level (each key based on
an ancestor level will have an expression that is the same as the ancestor’s level
expression). If the level key expressions associated with each level after
migration do not uniquely define each member in the level, then the cube will
no longer start.

* After migration, each dimension will have an "All" level, but the "All" level

member name will be blank. When the "All” level member name is blank in the
cube definition, the Cube Server will set the member name to "All” plus the
dimension name when the cube starts. For example, a dimension named
"Products” will have an "All” level member named "All Products.”

* After migration, all dimensions are of type Regular. We recommend that you

review you cube definitions and change the type to Time for dimensions related
to time.
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* After migration, all levels are of type Regular. You should review the level
types, especially for levels in time dimensions.

* After migration, the member cache by default is disabled. When the member
cache is disabled, all cube members will be loaded into memory when the cube
is started. This behavior is the same as in previous releases.

Chapter 2. Upgrading and migrating to V8.4 and V8.4.1 15
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Chapter 3. Enhancement requests addressed

The following enhancement requests have been addressed in the following
releases:

* 23060 — Would like an option to turn off sorting while maintaining the sorting
indicators in the user interface and related events. This capability is now
implemented. DataBlox has a new property internalSortEnabled and methods
isInternalSortEnabled() and setInternalSortEnabled(). The default is true. If
this property is set to false, the Blox user interface will show the sorting
indicators, but the internal sorting mechanism will be disabled.

e 21752 — Would like to be able to display formatted numbers. This is now
implemented. Data format in the Blox user interface is based on the browser’s
locale setting.
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Chapter 4. Issues addressed

Reported issues that have been fixed since DB2 Alphablox V8.3 are listed in the
following sections. A note may be added at the end of the issue when the fix
involves new behaviors or when additional information is available for further
clarification.

Assembly Workbench and examples-related fixes

¢ 23329 — Double-byte characters in an e-mail attachment based on the e-mail
example do not display correctly in Internet Explorer (e-mail sent as an HTML
e-mail does not have this problem). This has been fixed.

Note: When the e-mail is sent as an attachment, it is viewed in a browser rather
than in an e-mail reader. Internet Explorer displays a page based on the
default encoding that the user has specified. While the e-mail attachments
generated by DB2 Alphablox are now explicitly set to UTF-8 encoding,
users still need to specify in their browser to automatically select the
encoding. To do so in Internet Explorer, go to View » Encoding and select
Auto-Select. If the encoding is set to a double-byte character language,
the attachment will still display the characters incorrectly.

* 23102 - Getting NullPointerException in Query Builder when opening
Calculation Editor on merged dimensions. This has been fixed.

e 22013 — The Position Before setting in the Calculation Editor does not work if
member names contain colons or curly braces. This has been fixed.

Chart-related fixes
e 23324 — The "other” slice in pie charts always appears in English rather than the
correct locale. This has been fixed.

* 23116 — Format mask set on yl-axis (the ChartBlox ylFormatMask property) in
waterfall charts does not work. This has been fixed.

Data-related fixes

* 23136 — The generateQuery() method generates invalid query with Dynamic
Time Series in Essbase data sources. This has been fixed.

e 23112 — When multiple cubes have the same dimension, and the
selectableSTicerDimension property is set to the dimension in a cube other than
the first one, the getSelectableSTicerDimension() method always return the
dimension in the first cube. This has been fixed.

e 22620 — The setProperty("hiddenMembers") method does not work if the
member name contains commas or semicolons. This has been fixed.

Grid-related fixes

¢ 23099 — Cannot hide multiple columns selected in the grid with relational data.
This problem occurred only to relational data sources and has been fixed.

* 22748 — With a short GridBlox, when the grid space is limited, the horizontal
and vertical scroll bars might not appear. If the scroll bars appear, you cannot
scroll to see the last row or column. This problem has been fixed.
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Note: Now when the areas for the scroll bars are too small for both the scroll
buttons and the scroll bars, the buttons are automatically removed so you
can scroll to see the last row or column in most cases. In Firefox, there is
still a limit to how small the grid can go before data rows disappear. This
is a Firefox limitation.

General DHTML client and Ul components-related fixes

23319 — The title for the Organize Bookmarks... dialog contains question marks
in simplified Chinese. This has been fixed.

23079 — Choosing to Unhide All from a grid with compressed layout
(<bToxui:compressLayout>) results in an ArrayIndexOutOfBounds exception.
This has been fixed.

23067 — Getting NullPointerException when you click OK twice in the Undo
History dialog (by choosing Edit » History in the menu bar. This has been fixed.
23014 — After selecting Edit » Select All, the Edit > Copy menu item is not
available. This is now fixed.

22920 - Calling the DHTML CheckBox.setStyle( new Style(true,false,false)
) method does not set the style on the title text next to the CheckBox. This has
been fixed.

22905 — The drag-and-drop behavior in grids in expand/collapse mode
(expandColTlapseMode="true") is inconsistent. This has been fixed.

Alphablox Cube Server-related fixes

23355 — Adding a slicer to the PageBlox for an Alphablox Cube Server cube that
contains a calculated member causes com.alphablox.util. NotFoundException.
This has been fixed.

23211 - Drilling down on a relational cube generates out of memory exception
when the returned result exceeds the maximum rows and maximum columns
settings that are specified in the DB2 Alphablox Admin Pages. This has been
fixed.

Note: DB2 Alphablox will now enforce the maximum rows and maximum
columns specification prior to constructing the result set in order to
reduce the risk of out of memory condition. If suppression is enabled, the
limits are enforced on the result set size before rows or columns are
suppressed.

23199 — If a cube name contains certain Chinese characters, the cube will not
automatically start when the server is started. This has been fixed.

ReportBlox-related fixes

20

22933 — PdfBlox TogoSource property does not work. This has been fixed.

Note: When specifying the location for the image, you can specify either an
absolute path or a relative path. An absolute path is a path to the image
in the file system. For example, 1ogoSource="file:///C:\\alphablox\\
webapps\\images\\1ogo.gif". Note that you need to escape the back
slashes in the path. A relative path is a path relative to your DB2
Alphablox installation. For example, TogoSource="/repository/theme/
logo.gif".
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Platform-related fixes

23342 — After the parameters of an existing data source are changed using the
set command from the telnet console on the lead node, DB2 Alphablox cannot
connect to that data source from the normal node without restarting the cluster.
This has been fixed.

23316 — Hebrew characters are not right-aligned in the grid. This has been fixed.

23150, 23122 — When the lead node in a cluster stops or crashes, the other nodes
in the cluster hang. This has been fixed.

23082 — Using multiple Blox tags in WebLogic 8.1.4 produces
java.lang.NullPointerException. This has been fixed.

22917, 22855 — Deleting PresentBlox using bloxContext.deleteBlox() does not
delete its inner Blox. This has been fixed.

Note: This method also works on ReportBlox.

22904 — When DB2 Alphablox is installed behind WebSphere Secure Sockets
Layer (SSL), users receive errors complaining about trouble communicating with
DB2 Alphablox. This has been fixed.

Documentation-related fixes

23336 — Cell.getDoubleValue() does not generated
java.lang.NumberFormatException as documented. This has been fixed in the
Javadoc documentation. The NumberFormatException is no longer thrown, but
is still declared for the purpose of backward compatibility.

23208 — The GridBlox rowHeadingsVisible="false" property does not hide row
headers in the grid. The documentation for this property was incorrect. The
rowHeadingsVisible property does not define the visibility of row headers, but
the visibility of row dimension names above the row headings. This has been
fixed.

22864 — The Microsoft IIS post-installation information in the Installation Guide is
specific to Tomcat, but it is in the general post-installation section for 1IS v6. The
information has been modified to say that it is for Tomcat only, and for
WebSphere and WebLogic, users should consult the application server’s
documentation.
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Chapter 5. Known issues and workarounds

This section describes operational issues for DB2 Alphablox and its assembled
applications. Whenever possible, instructions for a workaround are provided. Use
the DB2 Alphablox tracking number when asking DB2 Alphablox Technical
Support for details on a particular issue. When running DB2 Alphablox
applications, you might encounter problems with a specific web server or web
browser. IBM is aware of some of these problems and in some cases can provide
you with workarounds for them. There are also known Hyperion Essbase, and
Microsoft Analysis Services issues that might affect your applications. See

[data source issues and workarounds” on page 30for details.

Known installation issues on Tomcat

This section lists known issues and workarounds for installation on Tomcat.

3.2.4 (DB2 Alphablox V8.4).

Tracking # Description Workaround

22863 IBM JDK v1.4.2 SR2 and SR3 do not work if | Use the 1.4.2 GA Release version (Windows/IA32,
you are using Tomcat 3.2.4 (DB2 Alphablox |cn1420-20040626) or SR4 instead.
V8.4).

21217 DB2 Alphablox service will not run if Tomcat NT service does not run properly when
Tomcat is installed in a directory that Tomcat is installed in a directory that contains

contains spaces. This only applies to Tomcat | spaces.

Workaround: Rename the Tomcat installation
directory name.

Known documentation installation issues

This section lists known issues and workarounds for the DB2 Alphablox

documentation installer.

Tracking # Description

Workaround

23216 Documentation installer does not
work on Linux with kernel 2.6.

The DB2 Alphablox documentation installer requires IBM JRE
1.4.2. This JRE version requires the following distribution
libraries:

* compat-libstdc++-33-3.2.3 and xorg-x11-deprecated-libs-6.8.1
(Intel® Architecture, PPC, and PPC64)

» compat-libstdc++-295-2.95.3 and xorg-x11-deprecated-libs-
6.8.1 (zSeries®)

When running the documentation installer on a Linux system,
if you encounter an error message saying that the installer is
not able to run in graphical mode, you need to install the
required library from your distribution CDs.

General installation issues

This section lists general notes and installation issues for the DB2 Alphablox 8.4

and 8.4.1 release.
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DB2 Alphablox to use WebSphere or
WebLogic Application Server, and your
repository is currently an Application
Server connection pooling data source, then
after the upgrade, DB2 Alphablox resets the
data source type to a normal
(non-connection pooled) data source.

Tracking # Description Workaround
23740 When both Microsoft SQL Server 2000 JDBC | There is a known issue with the 2000 version of the
Driver and the Microsoft SQL Server 2005 |JDBC driver incorrectly accepting the
JDBC Driver are enabled, running the "jdbc:sqlserver://" URL prefix if it is loaded first.
Repository Conversion Utility to convert to | When you use the Repository Conversion Utility to
a Microsoft SQL Server 2005 database convert to a Microsoft SQL Server 2005 database, the
repository produces errors. utility will connect to the Microsoft SQL Server 2000
JDBC Diriver first. This results in errors stating that
the Microsoft SQL Server 2000 JDBC Driver is unable
to perform the operation. The workaround is to
temporarily hide the Microsoft SQL Server 2000
JDBC Diriver from the Repository Conversion Utility
by either renaming the 2000 version of the JDBC
driver or deleting it before starting the Repository
Conversion Utility.
19134 When you upgrade from Alphablox 5 to Run the Repository Conversion Utility to reactivate

the usage of a Web Application Server connection
pooling data source.

Known platform issues

This section describes general platform issues and provides a table containing the
known issues and workarounds for DB2 Alphablox V8.4 and V8.4.1.

User interface

Tracking #

Description

Workaround

18795

If you have multiple calculated members on
a grid, you can bring up the member filter
to reorder the members. If you position the
calculated members next to each other, but
in a different order to the order specified in
the calculatedMembers property, they will
not be reordered and will keep the order
specified in the calculatedMembers property.

Modify the calculatedMembers property to reflect the
desired order.

Charting

Tracking #

Description

Workaround

22452

SAP BW and Microsoft Analysis Services
runtime calculated members do not appear
in 3D bar charts.

3D charts only show the lowest generation of
members in the query. OLE DB for OLAP runtime
calculated members have a generation level of 1 (the
highest level), and therefore will not appear in 3D
charts. There is no workaround.
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CommentsBlox

Tracking # Description Workaround

19355 Displaying a GridBlox containing cells with |Identify which indexes can be dropped to keep the
Comments from Comments Collection with |indexes for no more than 10 dimensions. You can
more than 10 dimensions will fail on DB2 also create different comments collections if your
UDB data sources. application can be segregated by the dimensions it is

accessing.

17873 When DB2 Alphablox is installed behind Instead of using the Connection Pool data source
WebSphere or WebLogic, if you attempt to | provided by the Application Server, connect using a
save a Comments collection against an data source created by the DB2 Alphablox
Oracle Connection Pooling data source Administration pages (e.g. under the Administration
provided by the Application Server, the tab -> Data Sources).

Comments Collection will not be saved
properly.

17200 When enabling comments in a PresentBlox, |Place the
if a nested <blox:grid ...
<blox:grid ... commentsEnabled="true"

commentsEnabled="true" S/
>
tag before the <blox:data ...> tag.
tag appears after the <blox:data ...> tag,
comments will not be properly enabled.
Data manager and data connection

Tracking # Description Workaround

23212 Drilling down on ragged hierarchies in SQL | No workaround. In SQL Server 2005 Analysis
Server 2005 Analysis Services data sources | Services, the provider string parameter MDX
fails. Compatibility=2 works differently with ragged

hierarchies when compared with Microsoft Analysis
Services 2000. Microsoft has acknowledged this
problem and states that it will be fixed in service
pack 1.

23144 In SQL Server 2005 Analysis Services, In your relational report based on ReportBlox, use
Microsoft re-architected the drillthrough the TextBlox columnHeader tag to rename these
feature. Drillthrough operations now return |columns with names that are more meaningful to
very technical column headers built from your users.
the column names of the relational tables.

DHTML client
Tracking # Description Workaround
21609 When a window containing a Blox is Adding code such as the example below will fix the

opened with a Javascript window.open ()
call, when this window is closed, dialogs
launched from the window do not closed
automatically and are left open.

problem:

<script>
window.onbeforeunload = function(){
presentBlox.closeAl1Dialogs();

}

</script>
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Tracking # Description Workaround
20702 With Internet Explorer v5.5, customizing the | This is only an issue with Internet Explorer v5.5, not
colors and styles of the browser’s native v6. Either avoid using this Internet Explorer-specific
scroll bars via CSS causes the grid and chart | CSS technique, or apply the custom styles only when
in a PresentBlox to move to the bottom of | the browser is not Internet Explorer v5.5.
the PresentBlox display area when you
hover over the menu items, toolbars, or
toolbar buttons.
20813 When a GridBlox’s border color for data None. Setting a table’s border is a Microsoft attribute.
cells, column headers and row headers is There is no public standard that applies to this
set in <themeName>_DHTML.css and the Blox | property, and underlying PDF engine does not
is exported to PDF, the background color of |support this attribute. See [this document on|
the entire GridBlox is also changed. |http:/ /msdn.microsoft.com}
19068 From the Tools > Internet Options menu of |Leave the setting at its default value of
Internet Explorer, changing the "Check for | Automatically. This is an issue with Internet
newer versions of stored pages” option Explorer.
setting on the General > Temporary Internet
Files > Settings panel from the default value
of "Automatically” to "Every visit to page”
can, in rare situations, cause the browser to
draw columns incorrectly.
17281 Altering the !DOCTYPE element to specify |Either do not specify a [DOCTYPE element, or use
the Strict declaration causes the grid to the Transitional or Frameset declarations.
display incorrectly (for example, <!DOCTYPE
HTML PUBLIC "-//W3C//DTD HTML 4.0
Strict//EN">)).
FastForward
Tracking # Description Workaround
16790 If multiple FastForward Administrators None.
update a template simultaneously, the most
recently saved changes will overwrite
previous changes.
16052 The FastForward templates will not work None.
against relational cubes.
DB2 Alphablox Cube Server
Tracking # Description Workaround
23499 Problems querying a DB2 Alphablox Cube |The "All’ level member should not have the same

Server cube when a member in a dimension
has the same name as the dimension.

name as the dimension. For example, if your
dimension is named "All Markets,” then do not set
the "All’ level member name to be "All Markets.”
Rename your dimension or the "All’ level member so
there are no name conflicts.
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Relational reporting

Tracking # Description Workaround

22350 When a Blox is rendered from right-to-left | There is no workaround at this time. The PDF

for bidirectional languages, any non-RTL rendering engine does not currently support the
characters (defined in the Unicode Unicode Bidirectional Algorithm.
Standard), such as the percentage signs
("%"), may change their position so the
rendered output may be different from
what is displayed in the browser.

19211 Due to the resolution of defect #19186, None.
toggling the sort option in a relational
report only toggles if the sort should be
ascending or descending. We no longer
change the flag which determines if missing
values should appear first or last during a
sort to match the isAscending flag.

18997 Using the browser’s back button after None.
performing a grouping operation on a page
with a relational report will repeat the
grouping operation on the first member of
the report.

PDF rendering

Tracking # Description Workaround

22916 Embedded HTML escape code in the page |Use the Unicode notation (\uXXXX) instead of HTML
filter drop-down list appears as HTML escape code. For example, instead of &#45; for a
escape code when the page is exported to | minus sign ("-"), use \u002d.

PDFE.

22350 When a Blox is rendered from right-to-left | There is no workaround at this time. The PDF
(RTL) for bidirectional languages, any rendering engine does not currently support the
non-RTL characters (defined in the Unicode |Unicode Bidirectional Algorithm. Depending on the
Standard), such as the percentage signs browser version and version of Unicode Standard it
("%"), may change their position in the supports, the specific non-RTL characters that may
rendered output. As a result the PDF output | change their positions in the rendered output may be
may be different from what is displayed in | different.
the browser.

17294 If you are installed behind WebLogic, and This message can be safely ignored.
have your WebLogic Server logging level
set to INFO, PDF generation may
occasionally generate a socket exception on
the console.

13617 In order to use render to PDF when None.

running DB2 Alphablox behind a Web
server, you must use the fully qualified host
name.
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Server-side programming

Tracking # Description Workaround

19213 The methods setBookmarkFilter and These methods continue to be available to DataBlox
getBookmarkFilter have been moved from |and all the data presentation Blox (ChartBlox,
the Blox class com.alphablox.blox.Blox to DataLayoutBlox, GridBlox, PageBlox, and
ViewBlox and DataBlox. PresentBlox) and will not affect existing applications.

However, if you have code that typecasts a data
presentation Blox to a Blox object to use these two
methods, the code needs to be changed.

18608 The To avoid a null pointer exception in your JSPs, check
MemberSelectEvent.getNewMemberSelections | for a NULL return value from this method, and
method will return NULL if any of the handle it accordingly.
selections in the Member Filter are function
calls, such as "Descendents of <member>.”

13782 You cannot access the When accessing the AASUserAuthorzationEnabled
AASUserAuthorizedEnabled property using | property using JSP tags, you must use the tag
the tag attribute AASUserAuthorizedEnabled. |attribute useAASUserAuthorization instead.

This is because the blox.t1d contains an
incorrect entry for the property
AASUserAuthorizationEnabled.

12380 The method waitOnBusy() does not work If possible, use waitOnBusy() from the data

when called from DataBlox. presentation Blox (e.g., ChartBlox, GridBlox,
PresentBlox) instead.
Telnet console

Tracking # Description Workaround

21048 DB2 Alphablox telnet session uses UTF-8 to |Use an alternative telnet client such as PuTTY.
communicate with the telnet client.

Windows does not have the capability of
setting the encoding to UTF-8. As a result,
Windows’ native telnet console will not
display properly on systems running
double-byte characters such as Chinese and
Japanese.

Apache Tomcat

Tracking

# Description Workaround

24084 When Apache HTTP Server 2.0 is This is a Tomcat configuration issue. This problem only happens

used as the Web server for Tomcat
5.5, you cannot access DB2
Alphablox from a remote client.
You can only access DB2 Alphablox
from the same system where
Tomcat 5.5 and DB2 Alphablox are

when you do not have a host named after the machine name,
which is a required pre-installation configuration step before you
install DB2 Alphablox.

You need to go through the host name configuration steps and
then reinstall DB2 Alphablox. See the [pre-installation steps for|

lusing the Apache HTTP Server 2.0 on Alphablox 8.4.1}

installed (using
http:/ /localhost:port /
path_to_alphablox_applications).
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Tracking

# Description Workaround
24061 Cannot render to Excel using This issue is caused by the no-cache headers set by Tomcat 5.5 in
Tomcat 5.5 and Internet Explorer its response. There are three possible approaches to resolve this
6.1. issue:
* Ch Wind ist tti for Int t Expl .
This is not an issue with the Export Change .your indows registry settings for Interne ! XP orer.
See |http:/ /support.microsoft.com/ default.aspx?scid=kb;en-|
to Excel feature (the Export to Excel | 5'3233()@] for more information
option from the toolbar or menu - )
bar in Blox user interface) where ¢ Configure the BasicAuthenticator setting in Tomcat’s
users are offered a selection of application deployment file so that the securePagesWithPragma
Excel templates to choose from. attribute is set to false. In your application’s XML context, add
This issue only affects the Excel the <Valve/> tag:
rendering mode when an <Valve className=
application is rendered in x1s "org.apache.catalina.authenticator.BasicAuthenticator"
format by setting the URL render securePagesWithPragma="false" />
attribute to x1s, or when the
contentType meta tag in your JSP is For more information, see Apache Tomcat’s documentation at
set to application/vnd.ms-excel. |http: / /tomcat.apache.org /tomcat-5.5-doc/ config / valve. html]
* Add a call to response.reset() in your application to remove
the no-cache headers.
<%@ page
contentType="application/vnd.ms-excel; charset=UTF-8"%>
<%@ taglib uri="bloxt1d" prefix="blox" %>
<%
if (application.getServerInfo().indexOf("Tomcat") >= 0)
response.reset();
%>
<html>
<head>
<blox:header/>
</head>
WebSphere Application Server
Tracking # Description Workaround
17894 When DB2 Alphablox is installed behind Editing the applications parameters and saving the
WebSphere 5, editing certain applications changes merely recreates a new .ear file. This
parameters for an existing application from |application must be "updated” via the WebSphere
the DB2 Alphablox home page’s Administration tools to redeploy the application with
Administration tab > Applications page, the changes.
will not immediately update the
application.
BEA WebLogic
Tracking # Description Workaround
18853 Running DB2 Alphablox behind WebLogic | This can be done via the Roles tab. Go to the "roles”

role does not get applied.

with IIS as the Web server and NTLM as
the authentication method is a supported
configuration. However, if you try to add a
role to a user through the "user” tab, the

tab and select the desired role (e.g.
AlphabloxAdministrator). Move the desired user
from the Available Users column to the Member
Users column.
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WebSphere Application Server

Tracking # Description Workaround

17894 When DB2 Alphablox is installed behind Editing the applications parameters and saving the
WebSphere 5, editing certain applications changes merely recreates a new .ear file. This
parameters for an existing application from |application must be "updated” via the WebSphere
the DB2 Alphablox home page’s Administration tools to redeploy the application with
Administration tab > Applications page, the changes.
will not immediately update the
application.

DB2 Alphablox in general
Tracking # Description Workaround
13750 IIS: Client cannot communicate with DB2 The steps to register an application on an external

Alphablox from a JSP file when DB2
Alphablox is running behind IIS.

Web server are documented in the Administrator’s
Guide > Application Definition > Steps to Register An
Application on an External Web Server.

Known data source issues and workarounds

This section documents known DB2 OLAP Server, Hyperion Essbase, and
Microsoft OLAP Services that affect DB2 Alphablox. The DB2 OLAP Server and
Hyperion Essbase issues are listed and, as available, details, examples, and
workarounds follow each issue. For some issues, tracking numbers are provided in
parentheses as a reference if you contact Technical Support to obtain more
information. DB2 Alphablox and Hyperion tracking numbers are clearly marked,
where available. You can also access the Hyperion Technical Support Web site for
more details on the latest Essbase patch.

Known DB2 OLAP Server and Hyperion Essbase issues

This section lists known issues for DB2 OLAP Server and Hyperion Essbase

databases.

* For On AIX® systems, the ESSLANG variable is always set to English. Since this
setting needs to match the Essbase server’s setting, and there’s no way to get
that information programmatically, you need to manually set the locale in
essbasesetup.sh before starting DB2 Alphablox. The essbasesetup.bat file is
located inside <db2alphablox_dir>/bin. For example, to set the locale to
Japanese, the ESSLANG variable might be set to Japanese_Japan.JapanEUC@Binary,
where the value string is formed by <language>_<territory>.<code page
name>@<sortsequence>. For details on locale specifications, see the Database
Administrator’s Guide for DB2 OLAP Server or Hyperion Essbase.

* When connecting to Essbase data sources via Hyperion Essbase Deployment
Services (EES), numeric values will improperly be returned as strings for Essbase
native drillthrough reports. This is a Hyperion issue. The workaround is to
bypass EES and connect to Essbase natively. (Hyperion Case #370427, DB2

Alphablox tracking #18668)

* If the Essbase essbase.cfg configuration file has the SSLOGUNKNOWN property
changed from its default value to FALSE, retrieving a Bookmark may display
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members which no longer exist in an outline. To avoid the problem, keep the
SSLOGUNKNOWN property set to its default value of TRUE. This will enable DB2
Alphablox to detect the problem and return the appropriate error message. (DB2
Alphablox tracking #17941).

* If you use Query Builder to construct a query against an Essbase data source
using a calculated column name that appears as a number (e.g. 300), a calculated
column error will be returned. The workaround is to rename the calculated
column to something non-numeric. (DB2 Alphablox tracking #14491).

* When using the {RENAME} command for a member, the interactivity in the grid is
lost (no drilldown), any changes made to the members in the Page axis are
ignored, any renamed members are not displayed in the chart. (DB2 Alphablox
tracking #12591).

* Using the ORDERBY command in your report specification returns members as a
concatenated string instead of returning the discrete members in a comma
delimited list. This causes an error to occur. Hyperion case #120488.

* Using { PRINTROW "n" } with <PAGE member clauses in your report specification
causes an error. Hyperion case #183804.

Known Microsoft Analysis Services issues

Microsoft SQL Server 2005 Analysis Services specific issues

* Drilling down on ragged hierarchies in Microsoft SQL Server 2005 Analysis
Services data sources fails, because the provider string parameter MDX
Compatibility=2 works differently with ragged hierarchies from that in
Microsoft Analysis Services 2000. Microsoft has acknowledged this problem and
states that it will be fixed in service pack 1.

* Writeback to leaf cells does not work properly. The DB2 Alphablox team is
working in conjunction with Microsoft to determine how to fix this issue.

When Connecting Using Certain Connection Strings

There is a known issue with DB2 Alphablox connecting to a MSAS data source,
when the connection string is set like the example below and when DB2 Alphablox
is started as a service.

MSOLAP;Execution Location=3;Client Cache Size=0;

This change is done by modifying the Provider field located on the Alphablox
admin pages for MSAS data source definitions. It is recommended you start DB2
Alphablox as a console application. However, if you must start it as a service,
follow these directions. In order for DB2 Alphablox to connect, the logon account
that starts the DB2 Alphablox Service must be modified, otherwise you will get an
Invalid Parameter error.

1. From the Control Panel open the Administrative Tools folder and select
Services.

2. Bring up the properties for your DB2 Alphablox service.
3. Select the Log On tab and select the This Account radio button.

4. Select a domain account. This domain account must have the Local Security
setting “Log on as a service.” If not, from the Control Panel open the
Administrative Tools folder and select Local Security Policy and give this
domain account the required right.
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This will allow DB2 Alphablox to connect with the MSAS data source, however,
the username and password which is used to connect to the data source will be the
domain account mentioned earlier. This is a known issue and is being investigated.

OLAP Services and Authentication

Microsoft Analysis Services uses Windows-based authentication. To use Windows
-based authentication in DB2 Alphablox applications that access Microsoft SQL
Server OLAP Services, the userName and password properties passed by DB2
Alphablox to Microsoft OLAP Services must be Windows users and passwords.

If DB2 Alphablox and Microsoft SQL Server OLAP Services are in different
domains, they must be trusted Windows domains.

For details on setting up your Windows machines to access OLAP Services and/or
Analysis Services, see the Administrator’s Guide.

Installing a User with Different Locale

If you are installing on a machine where the locale of the user who is logged in is
different from the locale of the machine, the DB2 Alphablox will not correctly
determine if the MDAC components are installed. If you encounter this problem,
set your locale to the machine locale. (DB2 Alphablox Tracking #13294)
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Chapter 6. Removed functionality and platform support

The following deprecated features are removed (both V8.4 and V8.4.1):
* Java client

 HTML Links client (also known as the thin client)

* SmartCacheBlox

* StatusBlox

* SpreadsheetBlox

¢ The Automatic Save Enabled option in the application definition page in the
DB2 Alphablox Admin Pages.

The following platforms are no longer supported:
* Solaris 8

* WebSphere Portal 5.1.0.1

» AIX 5.1 (32-bit and 64-bit)

* SunOne (iPlanet) 4.1

* Sybase for database-based repository

With the availability of the DHTML client since V5 and with the DHTML client’s
superior flexibility and extensibility, the Java client and the thin client had been
deprecated and are removed in this release. SmartCacheBlox and StatusBlox apply
to Java-client only, and therefore are also removed.

Additional removed platforms and features in V8.4.1

In addition to the above removed features and platform supports, V8.4.1 also
removes the following features and platform support:

* Tomcat 3.2.4
e iPlanet 6.0
* Apache HTTP Server 1.3

e The Authorized client list in the DB2 Alphablox Admin Pages (use the security
feature in Tomcat 5.5 instead)

Removed Blox methods

Blox methods that only apply to the Java, links, or HTML clients have been
removed from V8.4 and V8.4.1. These methods are organized based on the Blox
they are associated with.

General Blox methods for AbstractBlox

The following methods for AbstractBlox have been removed. Since AdminBlox,
BookmarksBlox, CommentsBlox, ContainerBlox, DataBlox, RepositoryBlox,
ResultSetBlox, and StoredProceduresBlox extend AbstractBlox, these changes apply
to them as well.

» getClassid(), setClassid()
» getCodebase(), setCodebase()
* getType(), setType()
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* jsMayscriptEnabled(), setMayscriptEnabled()
* updateProperties()

General Blox methods for DataViewBlox

The following methods for DataViewBlox have been removed. Because ChartBlox,
DataLayoutBlox, GridBlox, MemberFilterBlox, PageBlox, and PresentBlox extend
DataViewBlox, these changes apply to them as well.

e getBorder(), setBorder()
» getBorderTitle(), setBorderTitle()
» getlLocaleCode(), setLocaleCode()

ChartBlox

* getChartFrameRectangle(), setChartFrameRectangle()
* getFootnoteRectangle(), setFootnoteRectangle()
* getlLegendRectangle(), setLegendRectangle()

e getPieFrameRectangle(), setPieFrameRectangle()
e getSubtitle(), setSubtitle()

» getSubtitleRectangle(), setSubtitleRectangle()
e getSubtitleStyle(), setSubtitleStyle()

e getTitleRectangle(), setTitleRectangle()

* getToolbarPosition(), setToolbarPosition()

* islLegendWrapped(), setLegendWrapped()

e getWindowStyle(), setWindowStyle()

DataBlox

* getConsoleMessagelevel(), setConsoleMessagelLevel ()
» getControlStyle(), setControlStyle()

e getEventBookmarkDelete(), setEventBookmarkDelete()
» getEventBookmarkLoad(), setEventBookmarkLoad ()

» getEventBookmarkRename(), setEventBookmarkRename ()
» getEventBookmarkSave(), setEventBookmarkSave ()

* getEventDrillDown(), setEventDrillDown ()

* getEventDrillUp(), setToolbarFloatable()

e getEventError(), setEventError()

* getEventFilterChanged(), setEventFilterChanged()

e getEventHideOnly(), setEventHideOnly()

* getEventKeepOnly(), setEventKeepOnly()

* getEventPivot(), setEventPivot()

» getEventRemoveOnly(), setEventRemoveOnly()

» getEventShowA11(), setEventShowAl1 ()

* getEventShowOnly(), setEventShowOnly()

* isThinApplet(), setThinApplet()

DatalayoutBlox
* getWindowStyle(), setWindowStyle()
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GridBlox

getCellBandingStyle(), setCel1BandingStyle()
getCellMenultemName(), setCel1MenultemName ()
getCellStyle(), setCellStyle()
getColumnHeadingStyle(), setColumnHeadingStyle()
getDataColumnsPerPage(), getDataColumnsPerPage()
getDataRowsPerPage(), setDataRowsPerPage()
getEventAddComments (), setEventAddComments ()
getEventCelIMenultem(), setEventCelIMenultem()
getEventDisplayComments(), setEventDisplayComments ()
getEventEditCel1End(), setEventEditCel1End()
getEventEditCel1Start(), setEventEditCellStart()
getEventHeaderLink(), setEventHeaderLink()
getEventHeaderMenultem(), setEventHeaderMenultem()
getEventMemberClick(), setEventMemberClick()
getEventTriggerDrill1Through(), setEventTriggerDrillThrough()
getGenerationStyle(), setGenerationStyle()
getHeadingStyle(), setHeadingStyle()
getRowHeadingStyle(), setRowHeadingStyle()
getToolbarPosition(), setToolbarPosition()
isATwaysShowLastColumn(), setATwaysShowLastColumn ()
isATwaysShowLastRow(), setATwaysShowLastRow()
isHidePTusMinus (), setHidePTusMinus ()
isHtm1ColumnHeadersWrapped(), setHtmlColumnHeadersWrapped()
isHtm1ShowFul1Table(), setHtm1ShowFullTable()
isPaginate(), setPaginate()

isToolbarFloatable(), setToolbarFloatable()

PageBlox

getPagePanelType(), setPagePanelType()
getToolbarPosition(), setToolbarPosition()

PresentBlox

getDatalLayoutMaxWidth(), setDatalLayoutMaxWidth()
getToolbarPosition(), setToolbarPosition()
getWindowStyle(), setWindowStyle()
isIBarVisible(), setIBarVisible()
isToolbarFloatable(), setToolbarFloatable()

RepositoryBlox

delete3x()

getConsoleMessagelLevel (), setConsoleMessagelevel()
getUsersGroups ()

isThinApplet() , setThinApplet()

Tist3x()

Toad3x()
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* loadBytes3x()
e rename3x()

e save3x()

e search3x()

ToolbarBlox
* getAppletList(), setAppletList()
* isButtonBordered(), setButtonBordered()

FormPropertyLinkException for FormBlox
* getNestedException(), setNestedException()

Removed repository-related methods

This section lists all repository-related methods that have been removed in V8.4
and V8.4.1.

com.alphablox.blox.repository.Application
* isAutosave()
e isHtmlLinks()

com.alphablox.blox.repository.Server
e getClientBuildVersion()

e getClientIncrementVersion()

* getClientMajorVersion()

e getClientMinorVersion()

e getClientVersion()

e getMinimumClientBuildVersion()

e getMinimumClientIncrementVersion()
e getMinimumClientMajorVersion()

e getMinimumClientMinorVersion()

e getMinimumClientVersion()

Removed methods in Blox Ul Model

This section lists methods in the Blox UI Model (the com.alphablox.blox.uimodel.*
packages) that have been removed in V8.4 and V8.4.1.

BloxController

e actionFileExportToPDF_FOP()
* applyBorderTitle()

* applyToolbarFloatable()

PageBrixController
» applyPagePanelType()

Removed constant field values

Constant field values removed from V8.4 and V8.4.1 are organized based on the
Blox they are associated with. Fields for the Blox UI model are also listed.
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AbstractBlox
* RENDER_HTML
* RENDER_JAVA

RepositoryBlox

e VISIBILITY PUBLIC (Use RepositoryBlox.VISIBILITY APPLICATION instead)

Charting package in Blox Ul model

Axis:
* TabellLayoutMap

BarDataSeries:
e barStyleMap
* datalabelPositionMap

ChartGrid:
* linelLayoutMap
* lineTypeMap

ChartFillPattern:
* fillTypeMap
* imageModeMap

ChartLineSeries:
* lineTypeMap

ChartModelConstants:
* imageModeMap
* lineTypeMap

ChartRegionStyle:
* borderStyleMap
* imageModeMap

ChartSymbol:
* shapeMap
e styleMap

Dial:
* borderTypeMap
* ticPositonMap

DialNeedle:
* needleTypeMap

Legend:
* legendLayoutMap
* legendPositionMap
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LineDataSeries:
* TineTypeMap
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Chapter 7. Deprecated features and APIs

This section lists deprecated features, deprecated functionality, and their
replacements whenever possible.

Deprecated features and APIs receive support for a limited time but are no longer
a part of strategic product direction. IBM recommends eliminating their use as
soon as possible. Warning messages appear in the browser console whenever DB2
Alphablox encounters a deprecated API. Use these messages to identify application
pages requiring changes.

For IBM software support lifecycle policy, see the IBM Software Support Lifecycle
Web site at |ttp:/ /www.ibm.com /software/info /supportlifecycle /index.html|

Deprecated interfaces

The following interfaces are deprecated.

Interface deprecated in V8.4 and V8.4.1

Deprecated interface Replacement

ChartPageFilter in the com.alphablox.blox.filter package. The User and Group classes and the
PersonalizationManager interface in the same package.

Interface deprecated in V8.4.1

Deprecated interface Replacement

The following interfaces in the ) )

com.alphablox.personalization package are deprecated: ~ ChartPageListener in the com.alphablox.blox.event
+ IGroup package.

¢ IPEngine
e IUser

* IUserManager

Deprecated classes

The following classes are deprecated.

Classes deprecated in V8.4 and V8.4.1

Deprecated class New class

ChartPageEvent in the com.alphablox.blox.filter package. ChartPageListener in the com.alphablox.blox.event
package.
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Classes deprecated in V8.4.1

The following classes in the com.alphablox.personalization package are deprecated.
A new interface and new classes have been added for the new Personalization
Manager in V8.4.1.

Deprecated class Replacement

The following classes in the

com.alphablox.personalization package are deprecated ~ Use the new Personalization Manager in the
com.alphablox.personalization package, which includes the

PersonalizationManager interface, the User class, and the
Group class.

* AbstractGroup

* AbstractPEngine

* AbstractUser

* AbstractUserManager

* PEngineException

Deprecated APIs

The following methods are deprecated.
Deprecated APIs in V8.4 and V8.4.1

This table does not include methods in classes or interfaces that are deprecated.
See [“Deprecated interfaces” on page 39| and [“Deprecated classes” on page 39| for
complete lists of deprecated interfaces and classes.

Deprecated Methods New Methods

addEventFilter(), removeEventFilter()
For pre-event processing (event filters):

» addBookmarkDeleteFilter(), removeBookmarkDeleteFilter()
* addBookmarkLoadFilter(), removeBookmarkLoadFilter()

» addBookmarkRenameFilter(), removeBookmarkRenameFilter()
» addBookmarkSaveFilter(), removeBookmarkSaveFilter()

* addCollapseFilter(), removeCollapseFilter()

e addDrillDownFilter(), removeDrillDownFilter()

* addDril1ThroughFilter(), removeDrillThroughFilter()

* addDrillUpFilter(), removeDrillUpFilter()

» addExpandFilter(), removeExpandFilter()

* addHideOnlyFilter(), removeHideOnlyFilter()

* addHideOnlyFilter(), removeHideOnlyFilter()

* addKeepOnlyFilter(), removeKeepOnlyFilter()

e addMemberSelectFilter(), removeMemberSelectFilter()

* addPivotFilter(), removePivotFilter()

* addQueryFilter(), removeQueryFilter()

* addRemoveOnlyFilter(), removeRemoveOnlyFilter()

* addShowAl1Filter(), removeShowAl1Filter()

* addShowOnlyFilter(), removeShowOnlyFilter()

* addSwapAxisFilter(), removeSwapAxisFilter()
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Deprecated Methods

New Methods

For post-event processing (event listeners):
* addChartPageFilter()
* removeChartPageFilter()

addEventListener(), removeEventListener()

Common Blox methods:

e display()

* render

0

* renderHtmlHeader()

» renameBookmark()

* restoreBookmark()

display(), render(), and
renderHtmlHeader() now take BloxRequest
instead of HttpServletRequest, and
BloxResponse instead of
HttpServletResponse.

Use BookmarksBlox.getBookmark() to
rename (resave) a bookmark.

Use ToadBookmark() to restore a bookmark.

FormBlox:

* TimeUnitSelectFormBlox.setMultiple()

* SelectFormBlox.setMultiple()

* MemberSelectFormBlox.setMultiple()

* DimensionSelectFormBlox.setMultiple()
* CubeSelectFormBlox.setMultiple()

Use setMultipleSelect() instead.

RepositoryBlox:
e killSession()

* Jogout

No replacement.

com.alphablox.blox.repository:

* Application.getContextName()

e Application.getEntApp()

* Cube.createCubeDefinition() (four variations)

* Cube.setDataSourceName()

» DataSource.testConnection(HttpServletRequest)

* Server
* Server
* Server
* Server
* Server

.getClusteringMaxHosts ()
.getClusteringStartupWait()

.getMaxCubes ()

.getSmtpServer()

.isMaxcubesEnabled(), Server.getMaxCubes ()

For the name of an enterprise application,
use Application.getJ2EEAppName (), and
getModuleName ().

To create a Cube object and a DataSource
object, use
AdminBlox.createCubeDefinition() and
AdminBlox.createDataSource().

The DataSource.testConnection() method
now takes BloxRequest instead of
HttpServletRequest.

The Server.getClusteringMaxHosts ()
method now always returns 10. The actual
number of hosts in the cluster is unlimited.

The Server.getClusteringStartupWait()
method always returns 60. The actual
startup time is based on the clustering
inter-server protocol and can not be tuned.

The Server.getMaxCubes () method now
always returns 0.

For Server.getSmtpServer(), use your Web
application’s context parameters, or any
other preferred way of setting attributes
outside of DB2 Alphablox.

The Server.isMaxCubesEnabled() method
has no replacement, and always returns
false.

com.alphablox.blox.uimodel.BloxModel:

* setApplyThemeLayout ()

No replacement.
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Deprecated Methods

New Methods

com.alphablox.blox.uimodel.core.DateChooser:
* getImageURL()
* jsThemeBasedImage()

Use getIcon().getImageURL() and
getIcon().isThemeBasedImage() instead.

com.alphablox.blox.pdfreport. PDFReport:

addButton(), getBlox(), getBloxList(), getPrintable(),
resetPrintable(), setPrintable()

All methods now take BloxSession instead of
HttpSession and BloxRequest instead of
HttpServletRequest. See the Blox API change
list in the Javadoc documentation.

Chart legends:
* Legend.setlegendItemStyle()
* Legend.setlLegendRegionStyle()

Use the following methods instead:
* Legend.setTextStyle()
* Legend.setRegionStyle()

Deprecated fields and constants

The following fields and constants are deprecated.

Deprecated fields and constants in V8.4 and V8.4.1

Deprecated Constants

New Constants

DataSourceSelectFormBlox:

» IBMDB2JDBCDriver (Field Value: IBM DB2 JDBC Driver)

* OracleTyped4Driver (Field Value: Oracle Type 4
Driver)

* SybaseJConnectDriver (Field Value: Sybase JConnect
Driver)

* WebLogicMS_SQLServerDriver (Field Value: WebLogic
MS-SQL Server Driver)

DataSourceSelectFormBlox:

» DB2Driver (Field Value: IBM DB2 JDBC Driver)

* OracleDriver (Field Value: Oracle Driver)

e SybaseDriver (Field Value: Sybase SQL Server Driver)

e MSSQLDriver (Field Value: Microsoft SQL Server Driver)

RepositoryBlox:

TYPE_HASHTABLE

Deprecated constructors

The following constructors are deprecated.
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Deprecated constructors in V8.4 and V8.4.1

Deprecated constructors New constructors

All DateChooser constructors: Use the new factory methods instead:

* DateChooser() » DateChooser.getInstance()

» DateChooser(BloxContext, Date, ICalendar, » DateChooser.getInstanceWithContextLocale(Date,
IDateForamt) ICalendar, IDateFormat, BloxContext)

* DateChooser(Date) » DateChooser.getInstanceWithDate(Date)

* DateChooser(Date, ICalendar, IDateFormat, Locale) < DateChooser.getInstanceWithDatelLocale(Date,

+ DateChooser(Date, int) ICalendar, IDateFormat, Locale)

« DateChooser(ICalendar, IDateFormat, Locale) * DateChooser.getInstanceWithDateStyle(Date, int)

« DateChooser(int) * DateChooser.getInstanceWithLocale(ICalendar,

IDateFormat, Locale)
» DateChooser.getInstanceWithStyle(int)

com.alphablox.blox.logic: Use BloxDestroyedListener(BloxSession, Blox, String)

BloxDestroyedListener(HttpSession, Blox, String)

com.alphablox.blox.uimodel: Use MemberFilterBrixModel (Locale[])

MemberFilterBrixModel(),
MemberFilterBrixModel (String),
MemberFilterBrixModel (String, Locale[])

Deprecated telnet console command

The following telnet console command is deprecated.

Console command deprecated in V8.4.1

Deprecated command New command

ExtUserManager No replacement.
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Chapter 8. Docu

IBM

mentation

may periodically make documentation fix packs and other documentation

updates to the DB2 Alphablox documentation. If you access the DB2 Alphablox
library at [http: / /www.ibm.com /software /data/db2/alphablox/library.html| you
will always be pointed to the most up-to-date information with additional links to
technotes and white papers. The DB2 Alphablox information center on the IBM

Web

site at |http:/ /publib.boulder.ibm.com/infocenter /ablxhelp /v8r4m0 /index.jsp|

is updated more frequently than either the PDF or the hardcopy books.

Flexible installation option

You can choose to view the DB2 Alphablox documentation using the option that
best meets your needs:

* To
do

ensure that your documentation is always up to date, access all of your
cumentation directly from the DB2 Alphablox Information Center hosted on

the IBM Web site. By default, all links to the Information Center and to DB2
Alphablox Javadoc from the Admin Pages go to the IBM Web site for the latest,
most up-to-date information.

* To

keep your network traffic within your intranet, you can install the DB2

Alphablox documentation on a single server on your intranet. The DB2
Alphablox documentation installer offers two options:

The Install under an existing DB2 Alphablox installation option lets you
install the documentation under an existing DB2 Alphablox installation. With
this option, all links to the Information Center and to Javadoc from the DB2
Alphablox Admin Pages will be automatically modified to go to this locally
installed version.

The Install as a standalone Information Center option lets you install the
documentation anywhere without associating it with a DB2 Alphablox
instance. This lets you conveniently access the documentation during
application development on Windows systems. If you want the information
center link from the DB2 Alphablox Admin Pages to go to this standalone
installation, make sure the standalone information center is installed on a
server on the intranet. You can then modify the link as described in

[‘Installing as a standalone information center” on page 46

Note

: Information Center installed on your local system must be started first

before you can access it. On Windows system, use the shortcuts created. On
Linux and UNIX systems, run the IC_start.sh script. Both the shortcuts and
the location where the files are installed are described in
Istandalone information center” on page 46|

PDF documents

Information in the DB2 Alphablox Information Center is available as PDF files.

Visit

the DB2 Alphablox library page at Ihttp: / /www.ibm.com/software/data/ |

[db2/alphablox /library.html| for links to the PDF files and the information center.

The PDF documents are also located on the DB2 Alphablox CD under the
documentation/pdf directory. They are organized into their appropriate language
directories if a translated version is available. Check the English directory (the
en_US folder) for the complete set.
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Installing to an existing Alphablox installation

Choosing the "Install under an existing Alphablox installation” option when you
run the documentation installer will ensure all links to the Information Center and
to Javadoc from the DB2 Alphablox Admin Pages are automatically modified to go
to the installed version.

Table 1. Documentation installation location when documentation is installed under an
existing Alphablox installation

Component | Location Entry page
Information <alphablox_dir>/InfoCenter ic.html
Center

(To start the
information center,
run IC start.bat
or IC_start.sh)

DB2 <alphablox_dir>/system/documentation/ index.html
Alphablox javadoc/blox

Blox API

Javadoc

Blox API <alphablox_dir>/system/documentation/ changes.html
Change List  |javadoc/blox

FastForward | <alphablox_dir>/system/documentation/ index.html
API Javadoc  |javadoc/fastforward

Relational <alphablox_dir>/system/documentation/ index.html
Reporting API |javadoc/report

Javadoc

If, for any reason, you need to switch back to the IBM hosted information center,
or install the documentation on a separate system, see [‘Configuring the links to|
[information center and Javadoc documentation” on page 47

Installing as a standalone information center

Choosing the "Install as a standalone Information Center” option when you run the
documentation installer will install the Information Center and the Javadoc to the
directory you specify. This allows you to serve the documentation on a different
system in your intranet or to more easily access the documentation on your own
development system.

On Windows system, this will create an IBM DB2 Alphablox Online
Documentation program group with the following shortcuts:

* Documentation

— Information Center

— Start Information Center

— Stop Information Center
* Javadoc

— Blox API

— Blox API Change List

— FastForward API

— Relational Reporting API
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Note: If you choose to install only a subset of the documentation or Javadoc, the

shortcuts may be different.

Note: On Linux or UNIX systems, no shortcuts are created. See the following table
for the location and entry page for each documentation component.

Table 2. Documentation installation location for a standalone installation

Component | Location

Entry page

Information <alphablox_doc_install>

To start the

Center information center,
run IC_start.bat
or IC_start.sh. See
notes below for
instructions on how
to launch the
information center.

DB2 <alphablox_doc_install>/javadoc/blox index.html

Alphablox

Blox API

Javadoc

Blox API <alphablox_doc_install>/javadoc/blox changes.html

Change List

FastForward |<alphablox_doc_install>/javadoc/fastforward index.htm1

API Javadoc

Relational <alphablox_doc_install>/javadoc/report index.htm1

Reporting API

Javadoc

Note: To launch the information center:

* In a browser window, go to http://127.0.0.1:port_number /help /index.jsp.
The port number is specified during the installation. If you do not
remember the port number, this information can be found by opening the
IC_start.bat or IC_start.sh file in a text editor. The number after the
-port option is the port number for the information center.

* On Windows system, you can also use the Information Center shortcut
created under the IBM DB2 Alphablox Online Documentation program

group.

If you need to configure your DB2 Alphablox instance to point to your standalone

information center, see [“Configuring the links to information center and Javadod

[documentation.”|

Configuring the links to information center and Javadoc

documentation

You can manually modify the following files in your DB2 Alphablox installation to
point to where the documentation is installed. All these files are located under

<alphablox_dir>/system/documentation/.

Table 3. Files to configure for custom links to documentation

Link from the Admin Pages Points to
DB2 Alphablox Information Center ichtml
Blox API Javadoc jdoc_blox.html
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Table 3. Files to configure for custom links to documentation (continued)

Link from the Admin Pages Points to

Blox API Change List Javadoc jdoc_change. html
FastForward API Javadoc jdoc_ffwd.html
Relational Reporting API Javadoc jdoc_report.html

In the same directory there are two other versions for each of the entry page. One
points to the IBM hosted version (_hosted.html), and the other points to the locally
installed version (_local.html).

Switching to the IBM hosted documentation

If you need to switch back to the IBM hosted information center and Javadoc, copy
the hosted version of the entry page in the same directory over to the specified file
and remove _local from the file name, as shown in the following table.

Table 4. Files to use for IBM hosted documentation

Link from the Admin Pages | Copy this file Over to

DB2 Alphablox Information |ic_hosted.html ic.html

Center

Blox API Javadoc jdoc_blox_hosted.html jdoc_blox.html
documentation

Blox API Change List jdoc_change_hosted.html jdoc_change html
Javadoc documentation

FastForward API Javadoc jdoc_ffwd_hosted.html jdoc_ffwd.html
documentation

Relational Reporting API jdoc_report_hosted.html jdoc_report.html
Javadoc documentation

Switching to the locally installed documentation

If you need to switch back to the documentation installed under an existing DB2
Alphablox installation, copy the _local.html version of the entry page in the same
directory over to the specified file and remove _local from the file name, as shown

in the following table.

Table 5. Files to use for documentation installed under an existing DB2 Alphablox

installation

Link from the Admin Pages | Copy this file Over to

DB2 Alphablox Information |ic_local.html ic.html

Center

Blox API Javadoc jdoc_blox_local.html jdoc_blox.html
Blox API Change List jdoc_change_local.html jdoc_change html
Javadoc documentation

FastForward API Javadoc jdoc_ffwd_local.html jdoc_ffwd.html
documentation

Relational Reporting API jdoc_report_local.html jdoc_report.html
Javadoc documentation
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Switching to a standalone information center

If you have DB2 Alphablox documentation installed on a separate server on the
intranet and want to configure the link from DB2 Alphablox Admin Pages to point
to this installation:

1. Copy ic_hosted.html over to ic.html.
2. Modify the URL value in page’s <meta> tag for redirection:
<meta http-equiv="REFRESH" content="0; URL=http://server:port/help/index.jsp">
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Chapter 9. Accessibility

Accessibility features help users with physical disabilities, such as restricted
mobility or limited vision, to use software products successfully. DB2 Alphablox
has the following major accessibility features:

* Users can use keyboard shortcuts and accelerators to navigate and perform data
analysis actions in Blox user interface.

* Blox user interface in the DHTML client can be rendered in a high contrast
theme for users with limited vision.

* Blox user interface rendered using the high contrast theme honors the font size
display preference set in the browser.

* User can use keyboard shortcuts to navigate and interact with relational reports
created using ReportBlox.

¢ Administrative users can use keyboard shortcuts to navigate in the DB2
Alphablox Admin Pages to perform their administrative work.

* The DB2 Alphablox Information Center is in XHTML 1.0 format, which is
supported by most browsers.

* The DB2 Alphablox Information Center and end user online help honor the font
size display preference set in your browser.

Important: Accessibility is supported on Internet Explorer 6.0 only.
Keyboard navigation

Users of your applications can navigate and interact with data in Blox user
interface using only the keyboard. They can use keys or key combinations to
perform operations that can also be done using a mouse. The keystrokes are
generally consistent with the standard Windows keyboard shortcuts. Keyboard
navigation is also supported for interactive reports built using ReportBlox. For
more information, see [“Keyboard shortcuts and accelerators for Blox user
interface” on page 52| and [“Keyboard shortcuts for ReportBlox user interface” on|

[page 53.|

Accessible display

The DHTML client provides keyboard shortcuts for users to navigate and perform
data analysis actions using Internet Explorer. For users with limited vision, the
Blox user interface can be rendered in a provided high-contrast theme and the font
size setting specified in the browser is respected. For users with limited vision,
application developers can render applications using the high contrast theme
(theme=highcontrast). This can be achieved with user profile, such as via a custom
user property.

Compatibility with assistive technologies

You can use screen readers and other assistive technologies to read data in the Blox
user interface or in a relational report.
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Accessible documentation

DB2 Alphablox information center is provided in XHTML 1.0 format, which is
supported in most Web browsers. XHTML allows you to view documentation
according to the display preferences set in your browser. It also allows you to use
screen readers and other assistive technologies.

Limitations

Accessibility support in the Blox user interface has the following limitations:

* Keyboard shortcuts for navigating the Blox user interface are supported for
Internet Explorer 6 browsers only.

* The chart component is not accessible using the keyboard. It is recommended
that the chart component be removed from a PresentBlox (chartAvailable =
"false") or use only the grid component for users with disabilities.

* The toolbar component and the toolbar buttons on the toolbar are not accessible
using the keyboard. It is recommended that the toolbar be hidden
(toolbarVisible="false") for users with disabilities. Because toolbar buttons are
essentially shortcuts to a subset of the functionality available from the menu bar,
no functionality is lost when you set the toolbar to be not visible.

See the topic on [Designing an accessible application|in the Developer’s Guide for
more information.

Keyboard shortcuts and accelerators for Blox user interface

52

The keystrokes used to navigate in Blox user interface and interact with data are
generally consistent with the standard Windows keyboard shortcuts. Note the
following:

* Keyboard shortcuts are supported for Internet Explorer browsers only.

* Keyboard shortcuts for navigating inside the Chart component are not
supported.

The Blox user interface typically consists of some user interface components, such
as the grid and the chart that present the data, and user controls, such as menu
bars, drop-down lists, or buttons. User controls let you perform data analysis
actions. Below are the common keyboard shortcuts for using the Blox user
interface:

Table 6. General keyboard shortcuts

Action Shortcut

To move to the next or previous set of user |Use Tab and Shift + Tab to move forward
controls or component and backward.

For example, tabbing in a PresentBlox moves
you from the menu bar to the page filter, to
the data layout panel, and to the Grid.

To move to the next or previous item in a Use the arrow keys to go among the
set of controls individual menu items in a menu bar, data
cells in a Grid, or radio buttons in a set.

To select or deselect a radio button or Use the spacebar.
checkbox
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Table 6. General keyboard shortcuts (continued)

Action

Shortcut

To select and click a button

Use Tab and Shift + Tab to go to the next or
previous button.

Press Enter to simulate clicking of the
selected button.

Press Esc to cancel.

To execute the selected menu item or button
(equivalent to clicking a button)

Use the Enter key or spacebar.

To select a menu item in an active menu
using mnemonics

Press the letter underlined in the menu item
to select it.

To go to the menu bar while inside a Blox

Press Ctrl + Alt + M.

Table 7. Navigation and data analysis in grid

Action

Shortcut

To navigate among data cells in grid

When you tab to the grid and the whole
grid is selected, press the Down arrow key
to enter into the data cells. Then you can use
either the arrow keys or the Tab key to
move around the cells.

To bring up the right-click menu in a data
cell in the grid

Press Shift + F10.

To return focus back to the whole grid while
in grid data cells

Press Esc.

The whole grid is now in focus. This allows
you to tab to other controls or components.

To activate a drop down list such as in the
page filter

Press ALT+ Down arrow key.

To go to the menu bar while inside a Blox

Press Ctrl + Alt + M.

Table 8. Tree menu navigation

Action

Shortcut

To navigate in a tree menu

Use the Up and Down arrows keys.

To expand a collapsed node in a tree

Press the Right arrow key.

To collapse an expanded node in a tree

Press the Left arrow key.

Note: When you use a screen reader program, the screen reader takes control over
the keyboard, and the shortcuts described here may not apply.

Keyboard shortcuts for ReportBlox user interface

The keystrokes used to navigate in an interactive report built using ReportBlox are
generally consistent with the standard Windows keyboard shortcuts. The following
tables list the keyboard shortcuts for using the ReportBlox’s interactive context
menus and for styling a report using the Report Style Dialog.
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Table 9. General keyboard shortcuts for ReportBlox’s interactive menus

Action

Shortcut

To move to the next or previous group
header, column header, or group total
context menu

Use Tab and Shift + Tab.

The context menu automatically drops down
as you tab to the hot spot.

To select a menu item

Use the arrow keys to move to the desired
item and press Enter.

Table 10. Keyboard shortcuts for the Report Style Dialog

Action

Shortcut

To navigate among the controls

Use Tab and Shift + Tab to move forward
and backward.

To activate a drop-down list

Use Alt + Down arrow key.

You can also use the Up and Down arrow
key to scroll and make a selection without
expanding the drop down list.

To select an item in a drop-down list

Use the Up and Down arrow keys to move
to the desired item. Press Enter or Tab to set
the selection and move to the next control.

To select or deselect a radio button or
checkbox

Use the spacebar.

To apply the changes

Press Enter.

To cancel

Press Esc.

Note: Keyboard shortcuts are supported for Internet Explorer browsers only.

Note: When you use a screen reader program, the screen reader takes control over
the keyboard, and the shortcuts described here may not apply.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing, IBM Corporation, North Castle Drive, Armonk, NY
10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation, Licensing, 2-31 Roppongi 3-chome, Minato-ku, Tokyo
106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country
where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS
MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS” WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states
do not allow disclaimer of express or implied warranties in certain transactions,
therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:
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IBM Corporation, [46A/G4, 555 Bailey Avenue, San Jose, CA 95141-1003 U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application
programs conforming to IBM’s application programming interfaces.

Trademarks

The following terms are trademarks or registered trademarks of International
Business Machines Corporation in the United States, other countries, or both:

1-2-3° AIX AIX 5L™

Cube Views DB2 DB2 OLAP Server
DB2 Universal Database™ IBM Informix®
iSeries™ pSeries® Rational®

Red Brick™ Tivoli® WebSphere

56 1BM DB2 Alphablox: Release Overview



zSeries
Alphablox and Blox are trademarks or registered trademarks of Alphablox
Corporation in the United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Other company, product or service names may be trademarks or service marks of
others.
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